
Help me get to 
know you. Please 
complete for me 
while you wait for 
us to get started. 
Thank you

Utilize Microsoft 365 effectively 

to save up to 60 minutes a day
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Tracy van der Schyff
Microsoft Coach & Catalyst
Business Applications & Office Apps & Services MVP
The Guid Stuff, South Africa
@tracyvds
https://tracyvanderschyff.com
https://www.youtube.com/c/tracyvanderschyff

2021

Utilize Microsoft 365 effectively to 
save up to 60 minutes a day

@collab365 | @tracyvds
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• Microsoft | Office 365 Intro

• New Habits

• Operating System Hacks

• Microsoft 365 Apps for Enterprise

• OneDrive & Microsoft Teams

• Microsoft | Office 365 Time-saving Apps
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Disclaimer
The treadmill doesn’t 

make you lose weight.

Consistently using it 

does…

Invest in your greatest asset – YOU. For every hour spent in training / workshops, spend two going through the content, 

making notes / making sense of it all. Then repeat, repeat, repeat until it becomes a natural “way of doing”. Tracy
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Microsoft | 
Office 365 

Introduction
• Licenses
• Apps & Purposes
• Web, Desktop & Mobile Access
• MyAnalytics Dashboard, Digests,

Insights Outlook Add-In, & Inline

Suggestions
• Measurement & Reports
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Outlook add-in provides actionable insights to help you 

stay on top of your tasks and get more done.

Types of inline suggestions

The following are a few of the suggestions you 

might see in Outlook:

•Delay delivery

•Suggested outstanding tasks

•Get more time to focus

•Plan your time away

•Protect your focus time

•Shorten a meeting

•Track email open rate

•Track email
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https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#delay-delivery
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#suggested-outstanding-tasks
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#get-more-time-to-focus
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#plan-your-time-away
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#protect-your-focus-time
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#shorten-a-meeting
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#track-email-open-rate
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications#track-email
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Habits

• To Learn New Things, We Have To 

Unlearn Old Habits
• Why We Do Things The Way We Do?
• The Psychology Behind The Fear Of Tech
• Determining Roi On Time-Saving
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40% Of our 

actions are driven 

by habits rather 

than conscious, 

informed 

decisions.
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Teams reduces the total number of meetings and their duration. Online 

meetings conducted over Teams are reliable and of very high audio-

video quality. As a result, employees spend less time addressing setup and call 

quality issues, and more time interacting. The total time savings equal $6.9 

million.

Information workers save four hours per week from improved 

collaboration and information sharing. With Teams features like 

coauthoring, integrated file storage, and internal directory, information 

workers can effectively and efficiently collaborate in real-time. The potential 

savings equal more than $14.3 million.

Information workers save more than one hour per week by not having to 

switch between applications. Access to third-party and line-of-business 

apps inside Teams from any device benefits all workers, especially remote 

workers. This creates better employee cohesion and a common corporate 

culture across locations. The total savings are nearly $4.8 million.

Having resources available online in Teams reduces downtime by 14.6 

percent. When resources are available in one cloud-based location, downtime 

is reduced and complexity is lowered, making security and compliance 

easier. Compared to on-premises solutions, the time savings are worth 

$258,000 across information and Firstline Workers.
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Operating System Hacks

• Windows 10 / 11 Productivity Tips
• macOS Shortcuts & Tips
• Shortcuts / Multitasking
• Supercharged Search
• Training Resources
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• Use your Windows button to search for programs, files and 

settings on your machine – press the button, start typing –

enter to open.

• Windows + Left and Right Arrow will split your screens (on 

current screen)

• Windows + Shift + left and right arrow – will move screens 

to other physical screens

• Windows + D – goes to Desktop

• Windows + E opens File Explorer

• Windows + L locks your machine (do not do this if you do 

not have a password on your machine)

• Use the Windows button to search for programs, right click 

on search result – add to task bar. This will now appear on 

task bar at bottom of your screen.

• Search better with Boolean operators etc. – see 

my video which shows how to bring your search results 

down dramatically using “+” and “-“.

• To open search results in multiple screens (tabs) keep CTRL in 

while clicking on link

• CTRL + Shift + T reopens a tab you accidentally closed in the 

browser.

• Pin to Quick Access in Explorer
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• Quit many apps in a row: Cmd + Tab

• To completely delete a file: Option + Cmd + Delete

• To copy-paste a screenshot: Shift + Control + Cmd + 4

• To remove window overload: Cmd + F3

• To launch Spotlight search: Cmd + Space bar

• To invert colors on screen: Cmd + Option + F5

• To restore a closed tab: Cmd + Shift + T

• To quickly shut down a Mac: Control + Option + Command + Eject

• To launch Siri: Cmd + Space bar

• Cmd + Shift + A (for Applications)

Cmd + Shift + U (for Utilities)

Cmd + Shift + D (for Desktop)

• To close a current tab in Chrome: Cmd + W

To close a Chrome window: Cmd + Shift + W

To open a new Chrome tab: Cmd + T

• To paste text without formatting: Hold down Shift + Option + Cmd and hit V

• To paste emojis in the text: Press Control + Command + Space

• To apply strikethrough formatting: Cmd + Shift + X

• To select folder contents: Cmd + A

To delete a group of files after selection: Cmd + Delete

To empty the Trash: Cmd + Shift + Delete
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C Opens Teams Chat
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According to a McKinsey report, employees spend 1.8 

hours every day searching and gathering information. 

On average, that’s 9.3 hours per week!

The most powerful applications of social technologies in 

the global economy are largely untapped. By using 

social technologies, companies can raise the 

productivity of knowledge workers by 20 to 25 percent.

The social economy: Unlocking value and 

productivity through social technologies

McKinsey Global Institute
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Microsoft 365 Apps 
for Enterprise
• Explore AI-Powered Intelligent Features In Office
• Latest Features & Staying Up To Date
• Training Resources
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Most used  

business-critical

apps in your 

organization
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Reply faster using suggested replies in 

Outlook

When you receive a message that can be 

answered with a few words, 

Outlook suggests responses that you can 

use to reply with just a couple of clicks

Get relevant file suggestions when you 

search

When you type in the Search box, the most 

relevant files related to your search will be 

included in your suggestions.

Dictation is available in more languages

Dictation now supports 7 new languages: 

Hindi, Russian, Polish, Portuguese (Portugal), 

Korean, Thai, Chinese (Taiwan).

Draft documents with your voice

Use the new dictation toolbar, voice 

commands and auto-punctuation to draft 

documents.

Share to Teams

Share messages from Outlook with a person 

or channel in Teams.

Set online meeting options

Update your calendar settings to make every 

meeting you create a Teams Meeting by 

default, so you no longer need to remember 

to click the Teams Meeting option

Search for it the way you'd say it

Select the Search box at the top of Outlook 

and use your own naturally formed queries 

when you search in Outlook. 

Quick Steps

Quick Steps apply multiple actions at the 

same time to email messages. This helps you 

quickly manage your mailbox

Find Time / Scheduler in Cortana

Easy scheduling of meetings with external 

parties

Immersive Reader & Read Aloud

Immersive Reader in Outlook for the web 

and Read Aloud in Outlook desktop allow 

you to hear the text of an email read out 

loud while following along.

End meetings early or start late

Check the Shorten appointments and 

meetings checkbox and select End early or 

Start late depending on what you want.

Natural language search in Outlook

With Natural Language in search, you simply 

type the way you would ask a 

question/statement, no fancy syntax needed. 

We take the guess work out of choosing the 

right words and understand your intents 

expressed naturally.
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One-click writing suggestions

Apply writing suggestions with a 

single click. The updated Editor 

pane makes it easy to navigate 

between suggestions.

Draft documents with your 

voice

Use the new dictation toolbar, 

voice commands and auto-

punctuation to draft documents.

New images to bring your 

documents to life

Thousands of royalty-free stock 

images, icons, and stickers you 

can use in your documents. Go 

to Insert > Pictures > Stock 

Images to get started.

Save shapes as pictures

In just a few clicks, save a shape, 

icon, or other object as a picture 

file so you can reuse it 

elsewhere.

Save to your pinned folder

Pinned folders stay near the top 

of your Save locations so you 

can quickly access the folder you 

need.

Know who's in your document

See who else is working along 

with you, and where they are in 

the document. You'd find this 

experience across other Office 

apps.

Up-level your writing

Go to Home > Editor to see 

everything from clarity to 

conciseness suggestions for 

your document.

Convert files to improve 

accessibility

Upgrade your files to the 

modern format to make them 

more accessible for everyone.

Say it another way

When you want to say it 

differently, Rewrite is there to 

help. Rewrite offers alternatives 

for finessing your phrases.

Take your doc from static to 

stunning

Transform your document into 

an interactive, easy-to-share 

web page that looks great on 

any device.

Create more accessible PDFs

Create a PDF and the 

accessibility checker will point 

out accessibility issues to fix 

before you save.

Annotate your private copy

Create handwritten notes for 

your eyes by making a private 

copy of a shared document. Go 

to View > Create a Private Copy 

to get started.

Smart Lookup / Researcher

Select a word or phrase, right-

click it, and choose Smart 

Lookup for web results, or use 

research to find articles and cite 

references.

Better collaboration with 

modern comments

Have control of when you send 

comments to your co-authors, 

easily @mention notifications.

Dictation is available in more 

languages

Dictation now supports 7 new 

languages: Hindi, Russian, 

Polish, Portuguese (Portugal), 

Korean, Thai, Chinese (Taiwan).

No more bouncing to the 

browser

You decide how links to Office 

documents open: in the browser 

or in the app. See Link Handling 

under File > Options > 

Advanced.
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Linked data types: Real data for real life

New linked data types bring you facts and 

data on hundreds of subjects to help you 

accomplish your goals right in Excel.

Improved Conditional Formatting dialogs

Conditional Formatting dialogs are now 

resizable, and now you can duplicate the rule 

with a single click.

Unhide many sheets at the same time

No need to unhide one sheet at a time 

anymore -- unhide multiple hidden sheets at 

once.

Insert data from picture

Take a picture of printed data and convert to 

text / table

Make polished Visio diagrams in Excel

Create data-driven diagrams like flowcharts 

or organizational charts from data in a 

worksheet.

Save to your pinned folder

Pinned folders stay near the top of your Save 

locations so you can quickly access the folder 

you need.

Have a question about your data? Ask 

Excel:

Excel Ideas allows you to ask questions about 

your data - no need to spend time writing 

formulas.

Tame your big workbook

Cells, formulas, charts, tables... get a 

snapshot of your workbook with Workbook 

Statistics.

Automatically use new data types

When you type a data value that resembles a 

stock or a geographic location, Excel offers to 

convert it to the right connected data type -

Stocks or Geography.

Chat with co-authors while you edit

Collaborate more effectively by chatting with 

your co-authors without leaving the app.

More insight from your data

Get a deeper understanding of your data 

using the new data profiling views in Power 

Query Editor.

Customize Ribbons

Build your own customized ribbon with all 

your favorite functions

Make quick edits using the Excel pen

With the action pen, you can directly 

handwrite in the cells, jot down data with ink 

that gets automatically converted to Excel 

data.

Filter and sort without disrupting others

Sort and filter your Excel file while 

collaborating with others with Sheet View. 

The view prevents you from being impacted 

by other user’s sorts and filters while 

coauthoring the document.

3D or World Maps

Click Insert > 3D Map > Open 3D Maps. The 

Launch 3D Maps window appears, showing 

your new tour. Select any cell in the Excel 

table or range of cells that has your data.
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No need for a clicker: your Surface 

earbuds have you covered

Use your Surface Earbuds to control 

PowerPoint presentations. Once paired, you'll 

need to enable the feature in PowerPoint to 

use it.

Design Ideas for great graphics

Create professional slide layouts 

with PowerPoint Designer Get design 

ideas. Ask for design ideas any time by 

choosing Design > Design Ideas on the 

ribbon

New images to bring your documents to 

life

Thousands of royalty-free stock images, 

icons, and stickers you can use in your 

documents. Go to Insert > Pictures > Stock 

Images to get started.

Save to your pinned folder

Pinned folders stay near the top of your Save 

locations so you can quickly access the 

folder you need.

Save time by going straight to new

Do not show the start screen when 

application starts

Zoom for dynamic slides

When you're presenting, you can use the 

zoom to go from one place in your 

presentation to another in any order you like.

More icons to match your mood

We've added over 300 new icons. Find them 

at Insert > Icons.

Recording

Use PowerPoint to record your slides or 

record videos of other apps for training etc.

PowerPoint Live

PowerPoint Live transforms your presenting 

experience - only in Microsoft Teams

Save as PNG, Video and GIFS

Use PowerPoint to create graphics for other 

applications.

Morph Transitions

The Morph transition in PowerPoint allows 

you to animate smooth movement from one 

slide to the next.

GIFs in a jiffy

One slide, one frame. Easily create looping 

GIFs in PowerPoint.

Sharpen your lines with SVG

For crisper, clearer images, save a chart, 

shape, or other illustration as a scalable 

vector graphic. Save your slides as SVGs too!

Rehearse your presentation with 

Presenter Coach

Get feedback on the things that help keep an 

audience engaged — like pacing, pitch, filler 

words, sensitive phrases, and more.

Contextual mini toolbar

PowerPoint now includes three additional 

buttons at the end of the Mini Toolbar, which 

are personalized for you based on your most 

recent actions in the app.
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Easily navigate and organize your 

notebooks

The OneNote for Windows 10 app window 

now offers more note-taking space by 

providing an easier way to control the 

navigation interface. You can choose to 

display the notebook, section, and page 

navigation panes only when you need them.

Mark your notes with custom tags

Using tags in your notes is a great way to 

visually call out and categorize important 

notes for follow-up (for example, to track 

action items after a meeting).

To create your own custom tags, click the Tags 

menu dropdown on the Home tab and then 

click Create New Tag.

Go easy on your eyes with Dark Mode

This new optional mode switches OneNote’s 

interface elements from light to dark — either 

as a color preference or as a functional 

benefit. Dark Mode can improve readability of 

your notes in low light environments, increase 

the legibility of the user interface, provide 

better contrast, and reduce eye strain.

View a feed of all your notes

The OneNote feed displays a chronological list 

that combines all the notes you’ve taken in 

different apps, including OneNote, Sticky 

Notes, and Samsung Notes.

Search for text phrases, not just keywords

In addition to searching your notes for specific 

keywords, you can now enclose any search 

phrase in quotation marks to find those exact 

words anywhere in your notes.

Improved printouts of Office files

Insert Word documents, Excel spreadsheets, 

or PowerPoint presentations as a virtual 

printout to include their pages as images in 

your notes.

Insert File Printouts

Insert files for easy search, for example 

operating manuals, recipes, procedures etc.

CTRL + E

Search across all notebooks, sections & pages.

Brainstorming & handwritten Notes

Use OneNote to take notes and draw for 

brainstorming.

Protect your OneNote pages

Add passwords on specific sections.

Research

Copy text from websites with automatic URL 

references.

Team Sharing

Easily share OneNote with others for 

collaboration.

Improved Print to OneNote

In Windows 10 Settings, select ”OneNote” as 

your default printer and then print files from 

any app or browser on your PC.

Video and Audio Recording

Use OneNote to record your in-person 

meeting audio / video.

Search for tagged notes

Searching for tags in your notes now displays 

matching tags in a separate search results 

pane.
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Operating Manuals

Conference and training notes

Buying preferences and specs for house

Clients / projects, meetings
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OneDrive | 
Microsoft Teams | 
SharePoint

• Understanding The New Information Architecture
• Creating Office Documents From Your Preferred 

Workplace
• Co-Authoring & Collaboration
• Seamless Integration With Other Apps & Services
• Teams:  Inspections | Bulletins | Idea Management
• Supercharged Search in Teams (+ Tags)
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Files stored on 

OneDrive (Web 

or synced to 

my PC Explorer 

/ Finder)

Files stored on 

OneDrive (Web 

or synced to 

my PC Explorer 

/ Finder)

Files stored on 

OneDrive (Web 

or synced to 

my PC Explorer 

/ Finder) and 

then shared 

with external 

parties through 

link via email

Files stored on 

OneDrive (Web 

or synced to 

my PC Explorer 

/ Finder) and 

then shared 

with employees 

through Teams 

Chat / Group 

Chat

Files stored in 

Teams 

(SharePoint) in 

structured 

channels / 

folders, 

allowing 

coauthoring 

and 

collaboration.

Files stored in 

SharePoint 

Intranet 

environment. 

Small group of 

contributors, 

large group of 

consumers. 

Personal Files Work Drafts Shared Externally
Shared Internally 

(Ad Hoc)

Shared 

Departmental or 

Team Level

Shared Internally 

with Large 

Audience

ME WE
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Teams Meeting & Calling recordings stored 

in OneDrive and SharePoint

Teams meeting and call recordings will now be 

stored in your OneDrive for Business

OCR on Photos

Take photos with mobile and within seconds, 

the text on the photos are searchable

Version History

500 Versions available of previous edits on 

files

Immersive reader in OneDrive & SharePoint

Users can now open documents directly in 

the Immersive Reader from inside OneDrive 

and SharePoint.

Link settings to the quick permissions

A more intuitive and discoverable drop-down 

menu to help you easily select a permission 

levels ( Can edit or Can view )

Expiring access for external users

SharePoint site administrators and OneDrive 

owners will have the authority to extend or 

remove access for the selected users

Exclude specific files from sync on macOS

Functionality in OneDrive for macOS that 

allows IT admins to prevent the OneDrive sync 

app from uploading certain files to OneDrive 

or SharePoint.

Jump to Page for PDF viewing

Users of OneDrive for iOS and Android will be 

able to navigate quickly to specific pages in 

PDFs

Outline for PDF viewing

Outline creates a clickable table of contents to 

help people who use OneDrive on iOS and 

Android to quickly navigate PDFs

Bookmarks for PDF viewing on Android

Getting back to your important PDFs in your 

mobile devices just got easier. Use the new 

bookmark option in OneDrive for Android to 

add bookmarks to your important content so 

you can pick up where you left off.

Page rotation for PDF viewing on iOS and 

Android

You can now leverage the page rotation tool 

to rotate one page or multiple pages, so you 

don’t have to switch your device’s 

screen orientation when reading a 

document in OneDrive.

Dark mode for web

Dark Mode for OneDrive web, for both 

commercial and personal accounts. In addition 

to its aesthetic appeal, Dark Mode also 

reduces eye strain and improves the battery 

life of your devices.

"At a glance" summaries in sharing emails

When users share Word files, the sharing e-

mail will now include new information like 

estimated time to read as well as key points in 

the document.

Create shared library in OneDrive web

The new streamlined experience backed by an 

Office 365 group, allowing you to specify the 

people you want to share with – and the new 

shared library appears immediately as a new 

content collaboration space for your team 

files.

Known Folder Move

Moving your important folders to OneDrive 

allows you to have the power of cloud in your 

most productive folders on Windows.
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Find a meeting recording based on what 

was said with Microsoft Search

You can now find meeting recordings in 

Microsoft Search based on the meeting 

transcript

Lock a meeting from additional joins

Organizers can now choose to lock their 

meetings to prevent subsequent join 

attempts.

Slide translate in PowerPoint Live in Teams

Make your slides more inclusive with slide 

translate in PowerPoint Live in Teams. This 

private setting allows you to see a 

personalized view of the slide where text is 

translated in your chosen language.

Teams Meetings Auto Recording

Meeting organizers are now able to set a 

single meeting occurrence or series to auto-

record by enabling the “Record automatically” 

setting from Meeting Options.

Paging on Video Gallery

When you are in gallery view mode, and there 

are more videos than what can be shown at 

once on the meeting stage, navigation 

controls < and > now appears below the 

Video Gallery.

Organization-wide background

You can now tailor your Teams meetings 

background to your organization.

Approvals in Teams

Create, manage, and share approvals directly 

from your hub for teamwork

Transfer Calls between desktop and mobile

The capability allows you to seamlessly move 

your calls between different devices, such as 

from your laptop to mobile phone.

Live transcription with speaker attribution

Live transcription allows you to follow and 

review conversations (in English-US) alongside 

the meeting video or audio in real time.

Meeting recap

Meeting recap helps teams stay on track and 

keep their work moving forward after the 

meeting is over.

Meet Now in Outlook client for Windows

You can now start an instant Teams meeting 

from the Calendar tab in Outlook for Windows 

by clicking Meet Now.

History Menu

The History Menu for Teams desktop clients 

displays your recently visited locations when 

hovering over the backward and forward 

navigation options.

Polls in Teams meeting

Attendees and guest attendees on mobile 

devices can now participate in Polls in Teams 

meetings.

Preconfigured website tab in Team 

Templates

As an admin you can now add a URL of their 

choice to the website tab in a team template.

Presenter mode

Presenter mode empowers presenters to 

customize how their video feed and content 

appear to the audience with powerful 

professional layouts

Custom attendee registration

Add a custom attendee registration page to 

your meetings or webinars to better manage 

attendance before your virtual event starts.
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Microsoft Viva Connections for Microsoft 

Teams

This enables people to discover and search 

intranet content, sites, and news from across 

the organization right in Microsoft Teams

Modern pages are getting collapsible 

sections

You can show page sections in an accordion 

view (collapsed or expanded).

Boost SharePoint news

The SharePoint news service delivers an 

intelligent view of news, meaning it's targeted 

to you based on factors like your role or 

location, and further personalized based on 

signals in Microsoft Graph about where, how, 

and with whom you work.

SharePoint Pages in Teams

Edit a page or news post in Microsoft Teams 

after you've added it as a tab in a Teams 

channel.

Microsoft Lists: Custom list templates

Today, we have several ready-made List 

templates designed to make it easy to get 

started tracking and managing information –

like events, issues, and requests.

SharePoint Auto News Digest updates

Time to up your game when keeping everyone 

informed.

SharePoint admin center

New information columns on Active sites page

SharePoint admin center

New homepage insights dashboard

Immersive Reader

Available in OneDrive and SharePoint for 

documents

Audience Targeting capability for Events 

Web Part

This provides the ability to target specific 

audiences per event within the SharePoint 

Events Web Part.

Focus mode for modern SharePoint pages

Focus on a greater amount of page content by 

hiding the site header, site navigation, and 

global navigation bar with one click.

SharePoint Events web part will display 

event images

SharePoint page authors who use the Events 

web part can enable an image to show per 

event.

SharePoint Page Analytics updates

Introducing analytics for SharePoint pages and 

news articles.

Version History

500 Versions available of previous edits on 

files. Can change to 50,000

Alerts

Ability to setup alerts on Item / Folder level
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Office 365 
Time-saving 

Apps

• Bookings
• Microsoft Forms 
• Microsoft Lists
• Sway
• To Do & Planner
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Microsoft Bookings makes scheduling and managing appointments 

a breeze. Bookings includes a web-based booking calendar and 

integrates with Outlook to optimize your staff’s calendar and give 

your customers flexibility to book a time that works best for them.
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Microsoft Forms is a basic, lightweight app intended to 

quickly collect information via surveys and quizzes.
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Sway is an easy-to-use digital storytelling app for 

creating interactive reports, presentations, personal 

stories and more. Its built-in design engine helps you 

create professional designs in minutes. With Sway, 

your images, text, videos, and other multimedia all 

flow together in a way that enhances your story.
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Microsoft Planner is a Kanban solution that 

simplifies task management for teams and is 

integrated across Microsoft 365 apps.

With Microsoft To Do you can easily create 

and sync your task lists across multiple 

devices, so you have your to do list available 

whether you are on your desktop, phone, or 

tablet.
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“Most geniuses—especially those who lead others—prosper not by deconstructing intricate complexities but by exploiting unrecognized simplicities.” Andy Benoit
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W
in

d
o

w
s

•Search

•Shortcuts

•Better naming 

conventions

•Less is more

•Use the AI 

features

O
u

tl
o

o
k •Quick Steps

•Dictation

•Read Aloud

•Insights

•Suggestions

•Find Time

•Scheduler

P
o

w
e
rP

o
in

t

•Design Ideas

•Morph

•Zoom

•Recording

•Alignment

•GIFs / Images

•Icons / Stickers

•Online Images 

O
n

e
N

o
te •Sections and 

pages

•Meeting minutes

•Operating 

Manuals

•Buying 

preferences

•Recording

•Search

•Tags

M
ic

ro
so

ft
 3

6
5 •Forms for Surveys

•Sway for 

Information Packs

•Lists to replace 

Excel

•Alerts in 

SharePoint

•Microsoft Lists

T
e
a
m

s

•Search

•Tags

•Tabs for co-

authoring

•Integration with 

other apps

•Mail a channel

•Who Bot
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Closing
QnA
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The Definitive Guide 

Employee Experience – Josh 

Bersin 

Do the right 

thing, for the 

right reasons.

In
tro

Ha
bi

ts
W

in
do

ws
Of

fic
e

Te
am

wo
rk

Of
fic

e 3
65

Cl
os

in
g Q

nA
Ho

m
e



Tracy van der Schyff
Microsoft Coach & Catalyst
Business Applications & Office Apps & Services MVP
The Guid Stuff, South Africa
@tracyvds
https://tracyvanderschyff.com
https://www.youtube.com/c/tracyvanderschyff

Thank You !

@collab365 | @tracyvds
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Microsoft | Office 365 Introduction

Microsoft 365 for Business | Microsoft 365

Compare Office 365 Enterprise | Microsoft

Compare Microsoft 365 Enterprise plans

MyAnalytics dashboard - Workplace Intelligence | Microsoft Docs

Activity Reports in the Microsoft 365 admin center - Microsoft 365 admin | Microsoft Docs

Microsoft Productivity Score - Microsoft 365 admin | Microsoft Docs

Microsoft Teams usage report - Microsoft Teams | Microsoft Docs

Inline suggestions in Outlook - Workplace Intelligence | Microsoft Docs

Productivity insights in Outlook - Workplace Intelligence | Microsoft Docs

Microsoft 365 Adoption | Get Started

Enabling Modern Collaboration – Microsoft Adoption

#Microsoft365 Day 354: To learn new things, we first have to un-learn the old bad habits. –

Tracy van der Schyff

#Microsoft365 Day 73: How we deliver IT Support should change – Tracy van der Schyff

#Microsoft365 Day 86 – The Evolution of Finding Stuff – Tracy van der Schyff

#Microsoft365 Day 129: ROI on Training, transform your business! – Tracy van der Schyff

(PDF) CTRL ALT DELETE Lost productivity due to IT problems and inadequate computer skills

Quantifying the value of collaboration with Microsoft Teams

Operating System Hacks

Windows 11 Keyboard Shortcuts - All Things How

Windows 11 (developing) keyboard shortcuts

A minimalist approach to computing with #Office365 and #Windows – Tracy van der Schyff

#Microsoft365 Day 152: PC Literacy basics everyone should know – Tracy van der Schyff

The State of Data Discovery & Cataloging.pdf (alteryx.com)

MGI_The_social_economy_Full_report.ashx (mckinsey.com)

The High Cost of Not Finding Information

Reality Check: Still Spending More Time Gathering Instead Of Analyzing (forbes.com)

OneDrive | Microsoft Teams | SharePoint

Enabling Modern Collaboration – Microsoft Adoption

Collaborative work management on the Microsoft Virtual Hub – Microsoft Adoption

OneDrive release notes - Office Support (microsoft.com)

Microsoft OneDrive Blog - Microsoft Tech Community

What's new in Microsoft Teams - Office Support

Microsoft Teams Blog - Microsoft Tech Community

Microsoft SharePoint Blog - Microsoft Tech Community

Microsoft 365 Apps for Enterprise

What's new in Outlook for Microsoft 365 - Office Support

Inbox Zero with Microsoft 365 Quick Steps in Outlook – Tracy van der Schyff

What's new in Word for Microsoft 365 - Office Support

What's new in Excel for Microsoft 365 - Office Support

What's new in PowerPoint for Microsoft 365 - Office Support
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https://www.microsoft.com/en-za/microsoft-365/business#coreui-heading-hiatrep
https://www.microsoft.com/en-za/microsoft-365/enterprise/compare-office-365-plans
https://www.microsoft.com/en-za/microsoft-365/compare-microsoft-365-enterprise-plans
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/dashboard-2
https://docs.microsoft.com/en-us/microsoft-365/admin/activity-reports/activity-reports?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoft-365/admin/productivity/productivity-score?view=o365-worldwide
https://docs.microsoft.com/en-us/microsoftteams/teams-analytics-and-reports/teams-usage-report
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/mya-notifications
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/overview/productivity-insights
https://adoption.microsoft.com/
https://adoption.microsoft.com/enabling-modern-collaboration/#:~:text=%20Microsoft%20designed%20the%20MOCA%20to%20address%20two,tools%20are%20designed%20to%20integrate%20to...%20More%20
https://tracyvanderschyff.com/2018/07/22/to-learn-new-things-we-first-have-to-un-learn-the-old-bad-habits/
https://tracyvanderschyff.com/2017/11/26/how-we-deliver-it-support-should-change/
https://tracyvanderschyff.com/2017/12/13/the-evolution-of-finding-stuff/
https://tracyvanderschyff.com/2018/03/17/roi-on-training/
https://www.researchgate.net/publication/259703359_CTRL_ALT_DELETE_Lost_productivity_due_to_IT_problems_and_inadequate_computer_skills_in_the_workplace
https://www.microsoft.com/en-us/microsoft-365/blog/2019/04/23/quantifying-value-collaboration-microsoft-teams/
https://allthings.how/windows-11-keyboard-shortcuts/
https://defkey.com/windows-11-shortcuts
https://tracyvanderschyff.com/2019/01/01/a-minimalist-approach-to-computing-with-office365-and-windows/
https://tracyvanderschyff.com/2018/04/12/pc-literacy-basics-everyone-should-know/
https://pages.alteryx.com/rs/716-WAC-917/images/The%20State%20of%20Data%20Discovery%20%26%20Cataloging.pdf
https://www.mckinsey.com/~/media/McKinsey/Industries/Technology%20Media%20and%20Telecommunications/High%20Tech/Our%20Insights/The%20social%20economy/MGI_The_social_economy_Full_report.ashx
https://computhink.com/wp-content/uploads/2015/10/IDC20on20The20High20Cost20Of20Not20Finding20Information.pdf
https://www.forbes.com/sites/forbestechcouncil/2019/12/17/reality-check-still-spending-more-time-gathering-instead-of-analyzing/?sh=639e73b528ff
https://adoption.microsoft.com/enabling-modern-collaboration/#:~:text=%20Microsoft%20designed%20the%20MOCA%20to%20address%20two,tools%20are%20designed%20to%20integrate%20to...%20More%20
https://adoption.microsoft.com/virtual-hub/modern-work/collaborative-work-management/
https://support.microsoft.com/en-us/office/onedrive-release-notes-845dcf18-f921-435e-bf28-4e24b95e5fc0
https://techcommunity.microsoft.com/t5/microsoft-onedrive-blog/bg-p/OneDriveBlog
https://support.microsoft.com/en-us/office/what-s-new-in-microsoft-teams-d7092a6d-c896-424c-b362-a472d5f105de
https://techcommunity.microsoft.com/t5/microsoft-teams-blog/bg-p/MicrosoftTeamsBlog
https://techcommunity.microsoft.com/t5/microsoft-sharepoint-blog/bg-p/SPBlog
https://support.microsoft.com/en-us/office/what-s-new-in-outlook-for-microsoft-365-51c81e7a-de25-4a34-a7fe-bd79f8e48647
https://tracyvanderschyff.com/2021/05/06/inbox-zero-with-microsoft-365-quick-steps-in-outlook/
https://support.microsoft.com/en-us/office/what-s-new-in-word-for-microsoft-365-4219dfb5-23fc-4853-95aa-b13a674a6670
https://support.microsoft.com/en-us/office/what-s-new-in-excel-for-microsoft-365-5fdb9208-ff33-45b6-9e08-1f5cdb3a6c73
https://support.microsoft.com/en-us/office/what-s-new-in-powerpoint-for-microsoft-365-e8ef980c-5b12-4fff-ae3f-0819e6a21a1f
https://support.microsoft.com/en-us/office/what-s-new-in-onenote-for-windows-10-1477d5de-f4fd-4943-b18a-ff17091161ea
https://techcommunity.microsoft.com/t5/office-365-blog/5-steps-to-get-you-collaborating-more-effectively-in-office-365/ba-p/376983
https://adoption.microsoft.com/microsoft-365-learning-pathways/
https://tracyvanderschyff.com/
https://support.microsoft.com/en-us/modernworkplace?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/view-usage-data-for-your-sharepoint-site-884b5a0e-ab1d-40a1-8c60-f8e46fb014f3
https://lookbook.microsoft.com/details/b0633491-127d-48bf-ba06-a0cdb6ec749f
https://www.microsoft.com/en-za/microsoft-viva/learning
https://support.microsoft.com/en-us/office/what-s-new-in-microsoft-365-95c8d81d-08ba-42c1-914f-bca4603e1426
https://www.microsoft.com/en-us/microsoft-365/roadmap?filters=
https://support.microsoft.com/en-us/training
https://adoption.microsoft.com/
https://docs.microsoft.com/en-us/microsoft-365/bookings/bookings-overview?view=o365-worldwide
https://support.microsoft.com/en-us/office/introduction-to-microsoft-forms-bb1dd261-260f-49aa-9af0-d3dddcea6d69
https://techcommunity.microsoft.com/t5/microsoft-forms-blog/what-is-microsoft-forms/ba-p/111019
https://www.microsoft.com/en-us/microsoft-365/microsoft-lists
https://resources.techcommunity.microsoft.com/microsoft-lists/
https://support.microsoft.com/en-us/office/create-a-new-form-or-quiz-3c39c220-e30e-401d-bb6f-c1861d5aea01
https://support.microsoft.com/en-us/office/create-a-list-from-the-lists-app-b5e0b7f8-136f-425f-a108-699586f8e8bd
https://support.microsoft.com/en-us/office/microsoft-planner-video-training-4d71390f-08d8-4db0-84ea-92fb078687c7
https://support.microsoft.com/en-us/office/sign-in-to-sway-b60d6dc4-d2bc-4740-ab1d-e2c4071dca03
https://support.microsoft.com/en-us/office/create-and-share-lists-4e5aeac6-8649-4813-aae5-2c2ddea2f292
https://joshbersin.com/wp-content/uploads/2021/07/EX-21_07-DefGuide-1.pdf?utm_campaign=Premium%20Content&utm_medium=email&_hsmi=140191482&_hsenc=p2ANqtz-9QF4A2NMR9tWrx4YjSe0_ovKimUtGQQe3rixwWfykkArW8yfHXYUa-i-eqRXY8JNfo33AiQrIcyJ19E4FS7BDLlhZ4og&utm_content=140191482&utm_source=hs_automation
https://tracyvanderschyff.com/2021/07/09/microsoft-modern-workplace-wellbeing-resources/


@collab365 | @tracyvds

Thought leadership: Culture / Future of work / Resilience / Wellbeing

•The future of work

•Navigating the complexities of hybrid work together

•Embracing a flexible workplace

•Learn how resilience can help your organization thrive

•Growing your business in a changing world

•New research reveals future work trends for South African organisations (Work

Reworked)

•Unblocking teamwork: 4 tools and strategies to improve collaboration

•New tools can help boost wellbeing and soothe unexpected stresses of working

from home

•Happy and productive at work: Predicting opportune moments to switch tasks and

take breaks

•A pulse on employees’ wellbeing, six months into the pandemic

•Seven ways we’re empowering every person and every organization to thrive in a

new world of work

•Doing what matters – prioritizing wellbeing at work

•Microsoft Workplace Insights

•Microsoft 365 Adoption Whitepaper

•Quantifying the value of collaboration with Microsoft Teams

•Strategies for Onboarding in a Hybrid World

Staying up to date

•Microsoft 365 Roadmap | Microsoft 365

•What’s new in Microsoft 365 – Office Support

•What’s new in Office 365 (latest features

released)

•Tech Community Blogs

Adoption

•Microsoft Adoption

•Microsoft Service Adoption Specialist | edX

•Microsoft 365 Learning Pathways

•App templates for Microsoft Teams

Product Training

•Teams Basics

•Microsoft Teams Adoption Guide

•Microsoft Lists Look Book

•SharePoint Look Book

•Yammer Look Book

•Microsoft 365 Training – Microsoft Support

•Office for the web training

•Manage your life with Microsoft 365

•Save Time Tips

•Office Quick Starts

•Windows 10 keyboard shortcuts – Microsoft

Support

•Keyboard shortcuts in Office

•Office Templates

•Office 365 on LinkedIn

•Docs.Microsoft.Com

•Microsoft Learn

•Microsoft Learn TV

•Build Fundamental Business Skills

•Crash Course in Microsoft Teams

Modern | Hybrid Workplace Training

•Workplace Transformation Site

•Hybrid workplace guides

•Modern Workplace Training

•Make meetings work for everyone no matter where they are

•Collaborate on files

•Collaborate with Office 365

•Collaborate with Office

•M365 Collaboration infographic

•Productivity Library

•Best practices for collaborating with Microsoft 365

•Guide to collaborative work management in Microsoft 365

•Streamline end-user training Collaborative Work Management

CWM Organizing with Tasks & Lists Guided Demo Managing &

Sharing Files in Teams Guided Demo Tracking Tasks on Mobile

Guided Demo

•The Art of Teamwork

•Measurement & Insights

•How Microsoft Productivity Score can help you build a more

resilient business

•The definitive guide to Productivity Score

•Microsoft Productivity Score

•Microsoft MyAnalytics

•Outlook Insights

•Introducing insights in Teams to power wellbeing and

productivity

•Office 365 Satisfaction Surveys

•Microsoft 365 Reports in the admin center

Microsoft Modern Workplace & Wellbeing Resources 

– Tracy van der Schyff
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https://www.microsoft.com/en-us/microsoft-365/blog/2020/07/08/future-work-good-challenging-unknown/
https://www.microsoft.com/en-us/resilience/hybrid-work-solutions
https://blogs.microsoft.com/blog/2020/10/09/embracing-a-flexible-workplace/
https://www.microsoft.com/en-us/resilience
https://info.microsoft.com/ww-landing-HBR-Whitepaper-Advancing-Business-Innovation-Gate.html?lcid=EN-US&ocid=oo_pg000000_comm_gdc_dg_dt_resiliencehome
https://news.microsoft.com/en-xm/2020/11/12/new-research-reveals-future-work-trends-for-south-african-organisations/
https://info.microsoft.com/ww-landing-unblocking-teamwork.html?LCID=en-CA
https://news.microsoft.com/features/new-tools-can-help-boost-wellbeing-soothe-unexpected-stresses-working-from-home/
https://www.microsoft.com/en-us/research/blog/happy-and-productive-at-work-predicting-opportune-moments-to-switch-tasks-and-take-breaks/
https://www.microsoft.com/en-us/microsoft-365/blog/2020/09/22/pulse-employees-wellbeing-six-months-pandemic/
https://www.microsoft.com/en-us/microsoft-365/blog/2020/09/22/seven-ways-were-empowering-every-person-and-every-organization-to-thrive-in-a-new-world-of-work/
https://news.microsoft.com/en-cee/2021/02/18/doing-what-matters-prioritizing-wellbeing-at-work/
https://workplaceinsights.microsoft.com/
https://adoption.azureedge.net/wp-content/uploads/2020/06/Accelerating-Modern-Workplace-Productivity-Adoption.pdf
https://www.microsoft.com/en-us/microsoft-365/blog/2019/04/23/quantifying-value-collaboration-microsoft-teams/
https://www.microsoft.com/en-us/worklab/
https://www.microsoft.com/en-za/microsoft-365/roadmap
https://support.microsoft.com/en-us/office/what-s-new-in-microsoft-365-95c8d81d-08ba-42c1-914f-bca4603e1426
https://support.microsoft.com/en-us/office/what-s-new-in-office-for-the-web-fc1de049-98f3-46da-a5aa-da4a19c3e909
https://techcommunity.microsoft.com/t5/custom/page/page-id/Blogs
https://adoption.microsoft.com/
https://www.edx.org/course/microsoft-service-adoption-specialist-2
https://docs.microsoft.com/en-us/office365/customlearning/
https://docs.microsoft.com/en-us/microsoftteams/platform/samples/app-templates
https://teamsdemo.office.com/
https://teamworktools.azurewebsites.net/tft/
https://resources.techcommunity.microsoft.com/wp-content/uploads/2020/07/Microsoft-Lists_Look-Book.pdf
https://lookbook.microsoft.com/
https://teamworktools.azurewebsites.net/yammer/Yammer%20Lookbook.pdf
https://support.microsoft.com/en-us/training
https://support.microsoft.com/en-us/office/office-for-the-web-training-e315b031-2bd5-40a1-99ca-264ebf2c8f96
https://support.microsoft.com/en-us/office/manage-your-life-with-microsoft-365-9e3c3d2f-afcb-4cb4-8cd6-3c610da68c30
https://support.microsoft.com/en-us/tips/home?wt.mc_id=OTC_HOME
https://support.microsoft.com/en-us/office/office-quick-starts-25f909da-3e76-443d-94f4-6cdf7dedc51e
https://support.microsoft.com/en-us/windows/windows-10-keyboard-shortcuts-3d444b08-3a00-abd6-67da-ecfc07e86b98
https://support.microsoft.com/en-us/office/keyboard-shortcuts-in-office-e765366f-24fc-4054-870d-39b214f223fd
https://templates.office.com/
https://www.linkedin.com/learning/topics/office-365?accountId=2270706&u=2270706&success=true&authUUID=I52T%2Bv1MQlaz1R3IXRvR8w%3D%3D
https://docs.microsoft.com/en-us/
https://docs.microsoft.com/en-us/learn/
https://docs.microsoft.com/en-us/learn/tv/
https://www.microsoft.com/en-us/store/workshops-training-and-events/professionals#all
https://www.microsoft.com/en-za/microsoft-teams/art-of-teamwork-guide/keep-learning/getting-started-with-teams/1
https://lookbook.microsoft.com/details/b0633491-127d-48bf-ba06-a0cdb6ec749f
https://support.microsoft.com/en-us/office/view-usage-data-for-your-sharepoint-site-884b5a0e-ab1d-40a1-8c60-f8e46fb014f3
https://support.microsoft.com/en-us/modernworkplace?ui=en-us&rs=en-us&ad=us
https://clouddamcdnprodep.azureedge.net/gdc/gdchHPKb2/original
https://support.microsoft.com/en-us/office/collaborate-on-files-7e4d2c1e-3f66-4de9-a4ae-6d4782f175a3?wt.mc_id=otc_collab
https://support.microsoft.com/en-us/office/collaborate-from-anywhere-using-microsoft-365-ac05a41e-0b49-4420-9ebc-190ee4e744f4?wt.mc_id=otc_collab
https://support.microsoft.com/en-us/office/collaborate-with-microsoft-365-0613cf58-e8e2-48bc-a358-c4ec38d14950?wt.mc_id=otc_collab
https://download.microsoft.com/download/e/f/b/efba474a-693c-4fdf-a936-394b1fee44b6/M365_Collab_infographic.jpg
https://support.microsoft.com/en-us/office/productivity-library-d8ab82a5-5f02-4439-816b-4a5d35133e48?ui=en-us&rs=en-us&ad=us
https://support.microsoft.com/en-us/office/best-practices-for-collaborating-with-microsoft-365-5144136b-1ff8-476f-bcba-00de0bdaa600?wt.mc_id=otc_home
https://teamworktools.azurewebsites.net/assets/Collaborative%20Work%20Management%20Pamphlet.pdf
https://adoption.microsoft.com/streamline-end-user-training/
https://techcommunity.microsoft.com/t5/microsoft-365-blog/maximize-results-with-collaborative-work-management-in-microsoft/ba-p/2393857
https://octe.azurewebsites.net/Microsoft/viewer/304/index.html#/0/0
https://octe.azurewebsites.net/Microsoft/viewer/304/index.html#/
https://octe.azurewebsites.net/Microsoft/viewer/304/index.html#/2/0
https://www.microsoft.com/en-za/microsoft-teams/art-of-teamwork-guide
https://techcommunity.microsoft.com/t5/microsoft-365-blog/how-microsoft-productivity-score-can-help-you-build-a-more/ba-p/1696726
https://techcommunity.microsoft.com/t5/microsoft-365/the-definitive-guide-to-productivity-score/m-p/1699414
https://adoption.microsoft.com/productivity-score/
https://www.microsoft.com/en-za/microsoft-365/business/myanalytics-personal-analytics
https://docs.microsoft.com/en-us/workplace-analytics/myanalytics/use/use-the-insights
https://techcommunity.microsoft.com/t5/workplace-analytics-myanalytics/introducing-insights-in-teams-to-power-wellbeing-and/ba-p/1675767
https://view.officeapps.live.com/op/view.aspx?src=https://fto365dev.blob.core.windows.net/media/Default/DocResources/en-us/Adoption/Sample_User_Satisfaction_Surveys.xlsx
https://docs.microsoft.com/en-us/microsoft-365/admin/activity-reports/activity-reports?view=o365-worldwide
https://tracyvanderschyff.com/2021/07/09/microsoft-modern-workplace-wellbeing-resources/

